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Fundamentos del Trading Rentable

C U R S O  G R A T U I T O

Los 4 pilares
Este manual condensa los cuatro fundamentos que separan al trader rentable del

trader que pierde dinero. Léelo entero, marca lo que no entiendas, y aplica lo

aprendido en cuenta demo antes de pasar a real.
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Bienvenida

C A P Í T U L O  0 1

¿Por qué la mayoría pierde?
El 80–90% de los traders pierde dinero. No por falta de inteligencia o

información, sino por ignorar 4 fundamentos básicos. Este manual los cubre

todos.

Cualquier trader profesional —independientemente del mercado, el método o el tamaño

de la cuenta— se apoya en cuatro pilares:

🧠

PIL AR 1  ·  PSICOLOGÍA

Controlar tus emociones (miedo, codicia, esperanza, venganza) y ejecutar el plan

aunque tu mente quiera saltárselo.

🛡️

PIL AR 2  ·  GESTIÓN DE RIESGO

Definir cuánto puedes perder por operación, calcular el lotaje correcto, y proteger

tu capital antes de pensar en ganarlo.

📈

PIL AR 3 ·  LECTURA DE GRÁFICOS

Saber leer estructura, tendencias, soportes y resistencias para detectar dónde el

precio reacciona.

🎯

PIL AR 4 ·  PRIMERAS ESTRATEGIAS

Tener al menos 1–2 setups concretos, reglas claras y plan de acción que puedes

repetir cientos de veces.



Y al final: saber ejecutar. Conocer la teoría y no saber abrir una orden en la plataforma

es el error más común. Por eso los últimos capítulos cubren paso a paso TradingView y

MT5.
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Pilar 1 · Psicología

P I L A R  0 1  ·  P S I C O L O G Í A  D E L  T R A D I N G

Las 5 emociones
El gráfico es solo el 30% del trading. El otro 70% es lo que ocurre dentro de tu

cabeza mientras el precio se mueve.

1. Miedo

Hace que cierres operaciones ganadoras demasiado pronto (porque "y si se da la

vuelta") y que dudes en entrar cuando aparece tu setup. Síntoma: cierras en +5 pips lo

que debió ser +30.

2. Codicia

El opuesto del miedo. Te lleva a mantener operaciones más allá del take profit, aumentar

lotaje sin plan, o entrar en setups dudosos buscando "más". Síntoma: una operación

rentable se convierte en perdedora porque no cerraste donde tocaba.

3. Esperanza

La emoción más cara del trading. Una operación va contra ti, llega al stop, y en vez de

cerrarla, mueves el stop "un poquito más allá" esperando que rebote. Síntoma: pérdida

del 2% planeada se convierte en pérdida del 10%.

4. Venganza

Pierdes una operación y abres otra inmediata, con doble lotaje, "para recuperar". Es el

patrón que destruye cuentas en una sola sesión. Síntoma: tras una pérdida, abres

operaciones impulsivas sin esperar tu setup.

5. FOMO (Fear Of Missing Out)

Ves que el precio sube fuerte sin ti dentro, y entras tarde porque "se está yendo".

Normalmente compras en el techo. Síntoma: entras DESPUÉS de un movimiento

grande, justo cuando se va a corregir.

ANT ÍDOTO  UNIVERSAL

Las 5 emociones se neutralizan con un plan escrito que sigues mecánicamente. Si tu

plan dice "no abro operación tras una pérdida durante 30 minutos", lo cumples aunque



la mente grite lo contrario.
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Pilar 1 · Psicología

P I L A R  0 1  ·  P S I C O L O G Í A  D E L  T R A D I N G

Sesgos y disciplina
Tu cerebro no fue diseñado para operar mercados financieros. Tiene atajos

mentales (sesgos) que en la vida cotidiana son útiles, pero en trading te arruinan.

Sesgo de confirmación

Buscas solo la información que confirma tu idea. Si compraste EUR/USD, lees titulares

alcistas e ignoras los bajistas. Solución: antes de entrar, escribe qué te haría cerrar la

operación. Si ese escenario se cumple, sales sin discutir.

Aversión a la pérdida

Sentimos una pérdida 2 veces más fuerte que una ganancia del mismo tamaño. Por eso

cerramos ganadoras rápido y aguantamos perdedoras. Solución: define stop y take

profit ANTES de abrir, y no los muevas jamás contra ti.

Efecto contagio (herd behavior)

Cuando todos compran, te dan ganas de comprar. Cuando todos venden, vendes. Es lo

opuesto a lo que hacen los profesionales. Solución: ignora redes sociales mientras

operas.

Rutina de un trader disciplinado

Momento Acción

15 min antes Revisar calendario macro del día, marcar zonas técnicas, definir riesgo total

del día

Durante Solo operar setups que cumplen 100% el plan. Si no hay setup, no se opera

Tras cada

trade

Anotar en diario: entrada, salida, razón, emoción que sentiste

Fin de semana Revisar todos los trades. Detectar patrones. Ajustar el plan

EJERC IC IO



Antes de cada operación, responde EN VOZ ALTA: "¿Cumplo mi setup? ¿Tengo SL

definido? ¿Mi riesgo es el del plan?". Si dudas en alguna, no entras.
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Pilar 2 · Gestión de Riesgo

P I L A R  0 2  ·  G E S T I Ó N  D E  R I E S G O

Las matemáticas del riesgo
Una pérdida no se recupera con la misma ganancia. Esta es la primera lección

matemática que todo trader debe interiorizar.

La asimetría brutal

Si pierdes… Necesitas ganar para recuperar

10% +11%

25% +33%

50% +100%

75% +300%

90% +900%

Por eso lo prioritario no es ganar mucho, sino perder poco cuando pierdes.

Las 3 reglas de hierro

REGLA  1 · 1–2% DE  RIESGO  POR  OPERACIÓN

Si tu cuenta es de 1.000 USD, tu pérdida máxima en cualquier trade es de 10–20 USD.

Esto te garantiza sobrevivir a 50 trades perdedores seguidos (que estadísticamente no

van a ocurrir).

REGLA  2 · DRAWDOWN  MÁXIMO  MENSUAL  DEL  6%

Si en un mes pierdes el 6% acumulado, paras. Revisas. Vuelves el mes siguiente. Esto

previene rachas emocionales que destruyen cuentas.

REGLA  3 · DIVERSIFICACIÓN  TEMPORAL, NO  DE  ACTIVOS

Nunca tengas más de 2 operaciones abiertas simultáneamente. Cuanto más posiciones,

menos control mental y mayor riesgo de correlación oculta.

CASO  REAL



Cuenta de 1.000 USD. Trader A arriesga 2% por trade. Trader B arriesga 20%. Ambos

pierden 5 operaciones seguidas. Trader A queda con 904 USD (recuperable). Trader B

queda con 328 USD (necesita +205% para volver). Misma habilidad, vidas distintas.
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Pilar 2 · Gestión de Riesgo

P I L A R  0 2  ·  G E S T I Ó N  D E  R I E S G O

Stop Loss, Take Profit, R:R
Cada operación se define por tres precios: dónde entras, dónde aceptas estar

equivocado (SL) y dónde tomas beneficio (TP).

Stop Loss (SL)

Es el precio en el que cierras la operación si el mercado va contra ti. Se coloca antes de

abrir el trade, no se mueve en contra. Tipos comunes:

Estructural: al otro lado del soporte/resistencia que justifica la entrada.

Por ATR: a 1.5× o 2× el ATR del activo (volatilidad media).

Por porcentaje: a un % fijo del precio (ej. 0.25% en índices).

Take Profit (TP)

Es el precio donde cierras en ganancia. Se coloca en la siguiente zona técnica relevante

(resistencia previa, máximo del día, FVG, etc.).

Ratio Riesgo/Beneficio (R:R)

Es la relación entre lo que arriesgas y lo que puedes ganar. Si arriesgas 10 USD para

ganar 30, tu R:R es 1:3.

R:R Tasa de aciertos necesaria para ser rentable

1:1 > 50%

1:2 > 33%

1:3 > 25%

1:5 > 17%

Con R:R 1:3 puedes equivocarte 3 de cada 4 veces y seguir siendo rentable. Por eso es

clave: no se entra a operaciones con R:R menor a 1:2.

Calculando el lotaje correcto



Fórmula práctica:

▸  C Á LC U LO  PA S O  A  PA S O

Cuenta: 2.000 USD · Riesgo: 1% = 20 USD · SL: 30 pips

Valor por pip = 20 / 30 = 0.66 USD/pip → lotaje ≈ 0.066 (entre micro y mini lote).

GalanFX · Fundamentos del Trading Rentable 07



Pilar 3 · Lectura de Gráficos

P I L A R  0 3  ·  L E C T U R A  D E  G R Á F I C O S

Estructura y zonas
El gráfico es el lenguaje del mercado. Aprender a leerlo es ver lo que los demás no

ven.

Las 3 tendencias posibles

Alcista: máximos crecientes (HH) y mínimos crecientes (HL). Buscar compras.

Bajista: máximos decrecientes (LH) y mínimos decrecientes (LL). Buscar ventas.

Lateral: el precio rebota entre dos niveles. Operar el rango o esperar ruptura.

Soportes y Resistencias

Niveles donde el precio se ha frenado o invertido en el pasado:

Soporte: nivel donde los compradores defendieron y empujaron al alza.

Resistencia: nivel donde los vendedores rechazaron y empujaron a la baja.

CÓMO  MARCARLOS  B IEN

Dibuja zonas (rectángulos), no líneas finas. Usa los cuerpos de las velas, no las

mechas. Confirma con al menos 2 toques previos del precio. Cuanto más toques, más

fuerte el nivel.

Multitemporalidad

Mira siempre 3 timeframes:

1. Superior (D1 o H4): para identificar la tendencia general.

2. Principal (H1 o M30): donde buscas el setup.

3. Inferior (M5 o M15): para afinar la entrada exacta.

La regla de oro: nunca operes contra el timeframe superior.
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Pilar 3 · Lectura de Gráficos

P I L A R  0 3  ·  L E C T U R A  D E  G R Á F I C O S

Indicadores esenciales
Solo necesitas tres indicadores para empezar. Más de tres es ruido y parálisis por

análisis.

1. EMA 200 (Media móvil exponencial)

La media móvil más respetada del mundo. Filtra tendencia macro:

Precio por encima de la EMA 200 → solo buscas COMPRAS.

Precio por debajo → solo buscas VENTAS.

Es un filtro brutal de calidad. Operar a favor de la EMA 200 multiplica tu tasa de acierto.

2. RSI (Relative Strength Index)

Mide si el precio está "caro" o "barato" respecto a su comportamiento reciente. Va de 0

a 100:

RSI > 70: sobrecompra. Cuidado al comprar.

RSI < 30: sobreventa. Cuidado al vender.

RSI ≈ 50: equilibrio.

Más útil: las divergencias. Si el precio hace nuevos máximos pero el RSI hace máximos

decrecientes, la tendencia se está agotando.

3. ATR (Average True Range)

Mide la volatilidad media del activo. Sirve para:

Calcular la distancia mínima del stop loss (≥ 1.5 × ATR).

Saber si el día es "tranquilo" (ATR bajo) o "salvaje" (ATR alto).

Ajustar lotaje a la volatilidad real.

SETUP  L IMP IO

EMA 200 para tendencia. RSI para confirmación. ATR para stop loss. Tres indicadores.

Cero ruido. Toma de decisión rápida.
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Pilar 4 · Primeras Estrategias

P I L A R  0 4  ·  E S T R A T E G I A  0 1

Rebote en soporte/resistencia
La estrategia más sencilla, fiable y didáctica para empezar. Si solo aprendieras

una, sería esta.

La idea

El precio respeta zonas técnicas hasta que las rompe. Mientras una zona no se rompa,

podemos operar el rebote dentro de ella.

Reglas de entrada

1. Marca soportes y resistencias en H4/H1 (mínimo 2 toques previos).

2. Espera a que el precio se acerque a la zona en H1/M30.

3. Confirma con una vela de rechazo:

En soporte → martillo o envolvente alcista.

En resistencia → estrella fugaz o envolvente bajista.

4. Verifica que el RSI esté en sobreventa (en soporte) o sobrecompra (en resistencia).

5. Entra al cierre de la vela de rechazo.

Stop y take profit

SL: al otro lado de la zona, a 1.5× ATR de distancia.

TP: en la siguiente zona técnica visible. R:R mínimo 1:2.

Cuándo NO operar este setup

Si el precio se acerca a la zona muy rápido (vela grande sin pausa).

Si la zona ya tuvo 4–5 toques previos (cuanto más toques, más probabilidad de

romper).

Si hay un dato macro importante en menos de 1 hora.

▸  E J E M P LO  C O N C R E TO

EUR/USD lleva una semana respetando 1.0850 como soporte (3 toques previos). En H1

cae al nivel y aparece un martillo claro. RSI = 28 (sobreventa). Entrada: 1.0855 · SL:



1.0830 (25 pips) · TP: 1.0920 (65 pips). R:R = 1:2.6. ✅
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Pilar 4 · Primeras Estrategias

P I L A R  0 4  ·  E S T R A T E G I A  0 2

Pullback en tendencia
Una de las estrategias más usadas por traders profesionales. Operas a favor de una

tendencia clara, esperando a que el precio "respire" para entrar.

La idea

En una tendencia alcista, el precio no sube en línea recta: sube, retrocede, vuelve a

subir. Esa pausa (pullback) es la oportunidad para entrar al precio óptimo.

Reglas de entrada

1. Identifica tendencia clara en H4: precio por encima de la EMA 200.

2. Marca el último mínimo significativo (HL) en H1.

3. Espera a que el precio retroceda hasta:

El último HL, o

El nivel de Fibonacci 50%–61.8% del último impulso.

4. Confirma con una vela de continuación alcista en esa zona.

5. Entra al cierre de esa vela.

Stop y take profit

SL: por debajo del HL (a 1.5× ATR).

TP: en el último máximo (HH) anterior. R:R mínimo 1:2.

Por qué funciona

Operas a favor de la tendencia (el viento a tu favor), en una zona donde otros

compradores también van a entrar. Multiplicas las probabilidades de éxito.

REF INAMIENTO  AVANZADO

Si el pullback coincide con un soporte previo Y la EMA 50 a la vez, la confluencia es

triple. Esas son las entradas con mayor probabilidad estadística.
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Pilar 4 · Primeras Estrategias

P I L A R  0 4  ·  E S T R A T E G I A  0 3

Ruptura confirmada
Operar cuando una zona técnica se rompe con fuerza. Sirve para entrar al inicio

de nuevos movimientos amplios.

La idea

Cuando el precio rompe una resistencia importante con volumen y cuerpo, suele iniciar

un movimiento extendido en esa dirección. El truco es esperar la confirmación: muchas

rupturas son falsas.

Reglas de entrada

1. Marca una resistencia (o soporte) clara que el precio haya respetado al menos 2

veces.

2. Espera a que el precio rompa la zona con:

Una vela de cuerpo grande (mínimo 1.5× el promedio).

Cierre claramente al otro lado de la zona (no mecha).

3. Espera al retest: que el precio vuelva a probar la zona rota desde el otro lado.

4. Si la zona aguanta como nuevo soporte (o resistencia), entra al cierre de la vela de

confirmación.

Stop y take profit

SL: al otro lado de la zona rota (en caso de fallar el retest).

TP: medida del rango previo proyectada desde la ruptura. R:R mínimo 1:2.

Cuidado con las trampas

Hay rupturas que no son rupturas: el precio cruza la zona, atrae stops y vuelve dentro.

Por eso esperamos al retest confirmado, no entramos en la ruptura inicial.

ERROR  FRECUENTE

Entrar en la ruptura inicial sin esperar retest. En 6 de cada 10 casos el precio vuelve

dentro del rango y te salta el stop. La paciencia del retest filtra el 80% de falsos



quiebres.
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Ejecución · TradingView

C A P Í T U L O  1 1

Operar en TradingView
TradingView es la plataforma de gráficos más usada del mundo. Para operar real

necesitas conectar un broker compatible (Capital.com, OANDA, Phillip Nova,

Tradovate, etc.).

Paso 1 · Abrir el panel de trading

En la parte inferior del gráfico verás varias pestañas. Haz clic en "Trading Panel" (o usa

el botón "Trade" en la barra de herramientas). Si no aparece, ve a Trading → Broker y

conecta tu broker.

EURUSD · 1H · OANDA + Operar

Paso 2 · Configurar la orden

1. Tipo de orden:

Mercado: se ejecuta al precio actual.

Límite: se ejecuta solo si el precio llega al nivel que indicas (más bajo si

compras, más alto si vendes).

Stop: se ejecuta al cruzar un nivel (útil para entrar a rupturas).

2. Cantidad (lotaje): según tu cálculo del 1–2% de riesgo.

3. Stop Loss: activa el checkbox y escribe el precio (o lo arrastras directamente en el

gráfico).

4. Take Profit: igual.

Paso 3 · Ejecutar y monitorizar

Resistencia 1.0920

Cantidad 0.10

SL 1.0830

TP 1.0920

COMPRAR

VENDER



Una vez configurada, pulsa "Comprar" o "Vender". La operación aparece como

"Position" en el panel inferior. Desde ahí puedes:

Mover SL/TP arrastrándolos en el gráfico (solo a favor tuyo).

Cerrar manualmente con el botón "Close".

Ver el P/L flotante en tiempo real.
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Ejecución · TradingView

Atajos útiles en TradingView

Atajo Función

Alt + T Línea de tendencia

Alt + H Línea horizontal (soportes/resistencias)

Alt + F Fibonacci

Shift + L Long Position tool (calcula riesgo automáticamente)

Shift + S Short Position tool

Espacio + click Replay (reproducir histórico)

La herramienta "Long/Short Position"

Es la herramienta más útil para principiantes. Te permite dibujar en el gráfico tu entrada,

SL y TP. Calcula automáticamente:

Pips de riesgo y de beneficio.

Ratio R:R.

Importe en USD según el lotaje que pongas.

Es perfecta para visualizar el trade antes de abrirlo. Si el R:R no llega a 1:2 visualmente,

descartas la operación.

Configuración recomendada

Gráfico: velas japonesas (no líneas).

Tema: oscuro (menos fatiga visual).

Indicadores fijos: EMA 200, RSI, ATR.

Alertas: configura alertas en zonas técnicas para que TradingView te avise cuando

el precio llegue (no estés pegado al gráfico).

PRO  T IP

Crea una "Watchlist" con tus 3-5 activos principales y otra con tus alertas activas.

Ahorrarás horas de scrolling al gráfico.
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Ejecución · MetaTrader 5

C A P Í T U L O  1 2

Operar en MetaTrader 5
MT5 es la plataforma estándar de los brokers Forex. La interfaz es menos visual

que TradingView pero su ejecución es más rápida y permite Expert Advisors

(bots).

Paso 1 · Abrir la ventana de orden

Hay tres formas:

Tecla F9 (lo más rápido).

Menú Tools → New Order.

Botón "New Order" en la barra superior.

📊 Order · EURUSD

Symbol: EURUSD

Type: Market Execution

Volume (lots): 0.10

Stop Loss: 1.08300

Take Profit: 1.09200

Sell · 1.08498 Buy · 1.08502

Paso 2 · Rellenar campos

1. Symbol: elige el activo (EURUSD, XAUUSD, etc.).

2. Type:

Market Execution: al precio actual.

Pending Order: para órdenes límite o stop futuras.

3. Volume: tu lotaje calculado.

4. Stop Loss: precio. Si lo dejas a 0, MT5 abre sin SL (PROHIBIDO).

5. Take Profit: precio. Puede dejarse a 0 si gestionas manualmente.



6. Comment: opcional, para identificar la operación en tu diario.

Paso 3 · Ejecutar

Pulsa Sell (precio bid, en rojo) o Buy (precio ask, en verde). La diferencia entre ambos

precios es el spread.

CUIDADO

Si pones SL/TP que infringen el "stops level" del broker (distancia mínima), MT5

rechazará la orden con un error "Invalid stops". Aumenta unos pips la distancia.
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Ejecución · MetaTrader 5

Gestión de la operación abierta

Una vez abierta, la operación aparece en la pestaña "Trade" del panel "Toolbox"

(inferior). Desde ahí:

Modificar SL/TP: click derecho en la posición → "Modify or Delete Order".

Cerrar manualmente: click derecho → "Close Position".

Trailing Stop: click derecho → "Trailing Stop" → elige los pips de distancia. El stop

se ajustará solo a favor tuyo.

Órdenes pendientes (Pending)

Útiles para no estar pegado a la pantalla. Cuatro tipos:

Tipo Cuándo se activa

Buy Limit Cuando el precio baja al nivel y queremos comprar barato

Sell Limit Cuando el precio sube al nivel y queremos vender caro

Buy Stop Cuando el precio rompe al alza un nivel (rupturas)

Sell Stop Cuando el precio rompe a la baja un nivel

One-Click Trading

En la esquina superior izquierda del gráfico hay un botón "One Click Trading". Activa

este modo para abrir operaciones con un solo click usando el tamaño de lote por

defecto. Úsalo solo cuando ya tengas mucha experiencia: es muy fácil clicar por error.

Configuración recomendada para principiante

Charts → Properties: fondo oscuro, velas verdes/rojas, grid sutil.

Tools → Options → Charts: marca "Show ask line" para ver el spread visualmente.

Indicators: EMA 200 (azul), RSI (panel inferior), ATR.

Sound: activa sonidos de alertas (View → Sound Configuration).

TRUCO

Si arrastras una operación abierta en MT5 (línea horizontal de la posición) hacia un

nuevo precio, te abre el cuadro de modificación de SL/TP directamente. Mucho más



rápido que el click derecho.
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Tu hoja de ruta

C A P Í T U L O  1 3

Tu hoja de ruta
Has leído los 4 pilares y has visto cómo ejecutar en las dos plataformas más

usadas. Lo que viene ahora decide si serás un trader rentable o no.

Tus próximos 90 días

1. Semanas 1–2: abre cuenta demo. Configura tu plataforma. Marca soportes y

resistencias en tus 2-3 activos. Aprende a usar la herramienta Long/Short en

TradingView.

2. Semanas 3–4: opera en demo con riesgo simulado del 1%. Ejecuta SOLO los setups

de las 3 estrategias del manual. Lleva diario.

3. Semana 5: revisa los 30+ trades de demo. Calcula tasa de aciertos, R:R promedio,

expectancy. Identifica qué estrategia te da mejor resultado.

4. Semanas 6–8: sigue en demo pero solo con la mejor estrategia. Afina detalles.

Mejora gestión.

5. Semanas 9–12: si llevas 6+ semanas con resultados positivos en demo y disciplina,

considera pasar a cuenta real PEQUEÑA (200–500 USD). Riesgo del 1% por trade.

Lo que NO debes hacer

Saltar a cuenta real en la semana 1.

Operar 4-5 activos a la vez "para diversificar".

Cambiar de estrategia tras 5 trades perdedores ("esta no funciona").

Aumentar lotaje porque ganaste 3 seguidos.

Operar 8 horas al día. Más de 2-3 horas concentradas es contraproducente.

🎬

No te pierdas el Curso Introductorio en formato vídeo

Próximamente publicaremos el curso completo en vídeo donde Luis Galán

explica cada uno de estos 4 pilares en pantalla, con casos reales del DOW y

NASDAQ.



Las personas registradas en este manual recibirán el aviso en primer lugar.

— Luis Galán

F UNDADOR  ·  GA L AN F X
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Recursos GalanFX

C A P Í T U L O  1 4

Mantente conectado
Aquí tienes todos los canales para seguir aprendiendo, unirte a la comunidad y

enterarte cuando el curso en vídeo esté disponible.

Web y plataforma

Recurso Enlace

Landing oficial galanfx.fly.dev

Sentimiento de

Mercado

App de Trading

galanfx.fly.dev/login

Informe

semanal

galanfx.fly.dev/static/reports/latest.html

Comunidad

Plataforma Enlace

WhatsApp

Grupo gratuito

chat.whatsapp.com/CPgOcgwVYj840rrrLYuaeb

Telegram t.me/galanfx11

Redes sociales

Red Handle

Instagram @galan3117

TikTok @galanfx

YouTube @GalanFX

Facebook Luis Galán

https://galanfx.fly.dev/
https://galanfx.fly.dev/login
https://galanfx.fly.dev/static/reports/latest.html
https://chat.whatsapp.com/CPgOcgwVYj840rrrLYuaeb
https://t.me/galanfx11
https://www.instagram.com/galan3117/
https://www.tiktok.com/@galanfx
https://www.youtube.com/@GalanFX
https://www.facebook.com/luis.galan.659344


OTROS  MANUALES  EN  ESTA  SER IE

Si quieres profundizar, descarga también gratis los manuales 01 · Introducción al

Trading, 02 · Velas Japonesas y 03 · Entendiendo el Mercado en la sección

Herramientas de la landing.
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https://galanfx.fly.dev/#herramientas
https://galanfx.fly.dev/#herramientas


G A L A N F X  ·  C U R S O  G R A T U I T O

"Los 4 pilares no se aprenden,

se construyen con repetición."

P R Ó X I M A M E N T E

🎬 Curso completo en VÍDEO.

Recibirás aviso en exclusiva si te registraste para este manual.



GALANFX
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